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Help On Using Help
The Help On Help Help menu option provides detailed instructions on how to use help.



Help Index
Use the help index to locate information and topics of interest.    Select item by clicking on 
the underlined title or phrase.



 Display or Print Name and Password List
Select Player Names & Passwords from the Display menu to display a list of players with 
their passwords.    You can print this list out if so desired by clicking on the printer icon at the
top of Player List.    Use this option to make a list to work from.    To flip pages click on the    
appropriate icon.



 Math Castle Grade Book
Each time a game is complete, Math Castle keeps a record of it.    Included in this record is 
the player's name, the level played, the function (addition, subtraction, multiplication, 
division, or All of Above), the time it took, and the score as a percentage of the number of 
problems answered correctly. If a student is unable to complete all problems in the problem 
set in the allocated time, the ones not completed are counted as wrong for this purpose.

Use this function to view the records of all students that have used Math Castle.    These 
records include scores from all games played by each student along with their grade point 
average.

Select Math Castle Grade Book from the Display menu to displayd the Grade Book on your 
screen.    Once the grade book is displayed, you can print it by clicking on the printer icon 
that is displayed at the top of the grade book.    To flip pages in the grade book click on the 
appropriate icon.



 Player Names and Passwords
Select Update Player Names & Passwords from the Utilities menu to access the Names & 
Password window.    Use this window to delete or add player names to the Math Castle 
database, assign passwords, and select password and name input options.

Checking the box " _ Allow addition of new players by Administrator only" will prevent
names from being added from within Math Castle.    With this box checked, all names must 
be added from within the Math Castle Administrator program.    Check this box if you want to 
prevent players from entering frivilous names, aliases, or from using more than one name or
variations of the same names such as:    Susan, Sue, Suzie, etc..

Checking the box " _ Require password verification of player's identity" will setup 
Math Castle so that players cannot gain access to Math Castle unless they first enter their 
password.    Passwords must be assigned by the administrator and entered from within the 
administrator program.    Checking this box will prevent players from using other players 
names.



 The User Problem Set Editor
Math Castle allows you to use a problem set that you define. This can be a special problem 
set that you create, or the problems that you need to practice from school.

A "User Defined Problem Set" is a problem set of your own making.    The User Set Editor is 
provided as a means for you to input the problems of your choice.

To access the User Defined Set Editor, select Edit User Defined Problem Set from the 
Utilities menu.

The problems that you enter must be placed in each problem box in the following format:

9900 + 99 = 9999

If you omit the equal sign and answer, then the equal sign and answer will be added for you.

The first number in a problem cannot be greater than 9999.    The second cannot be greater 
than 99.    The answer cannot not exceed 9999.    If you attempt to enter a number that 
exceeds these limits, an overflow error will occur.

The characters that the Editor allows are:

0, 1, 2, 3, 4, 5, 6, 7, 8, 9
+ as the addition symbol
- as the subtraction symbol
X, x, * as the times symbol
/ as the division symbol

User Set Editor error messages:

Error 6 - Overflow:    This error is returned if you attempt to enter a problem where one or 
more of its components contain too many digits. For example:

10000 - 12 = 9988    (First operator greater than 9999)

9999 - 999 = 9000    (Second operator greater than 99)

9990 + 10 = 10000    (Answer greater than 9999)

Error 11 - Division by Zero:    This error is returned when there is an attempt to enter a 
division problem with zero as the denominator. For example:

88 / 0 = Error

Error 77 - Remainder on Divide:    This error occurs when an attempt is made to enter a 
division problem whose answer does not come out to be a whole number.    Example:

1 / 2 = .5    (Answer is not a whole number)



Administrator's Password
The Administrator's Password is designed to allow access to the Math Castle 
Administrator Program by authorized persons only.    Before you run Math Castle the first 
time, be sure to start the Administrator program and enter your password before one of 
your students does.    Be sure to remember this password for you will need it before you 
can gain future access to the Math Castle Administrator.    If you lose your password you will 
need to re-install Math Castle from your original Math Castle diskettes.

You set the Administrator's Password by selecting Set Administrator Password under the 
Security menu.



Set for Network Usage
Math Castle can be ran on a network provided that you are running the Network Version of
Math Castle, and have enabled network operation by checking "Yes" on the Set for Network 
Usage choice on the Options menu.



Skip Introduction
You may choose to skip the initial song and story when you start Math Castle by checking 
"Yes" on the Skip Introduction choice on the Options menu.



Sound Override Options
Set the sound override options from the Sound Override Options choice on the Options 
menu.    You may choose from the following sound override options:

Auto-Detect (Use Best Option)
Select this option to have Math Castle automatically detect and set the sound device to 
the best sound option available.    With this option set, players can change the sound 
setting from within Math Castle.

Sound Card
Outputs all sound to the sound card.    The sound card must have been set up to run 
under Windows with the capability of playing .wav and midi files.    With this option set,
players can turn the sound off altogether but otherwise cannot override this setting.

PC Speaker
Outputs all sound to the PC Speaker.    With this option set, players can turn the sound 
off altogether but otherwise cannot override this setting.

Sound Off Use this option to turn all Math Castle sounds off.    The player cannot override 
this setting.

Note:    The Auto Detect selection will work properly only if your sound device has been 
specified in the AUTOEXEC.BAT file with the "SET SOUND=" command.



Auto Advancement
In order to advance to the next level, the player must answer enough problems correctly to 
obtain a percentage that is equal to or greater than the Percentage Requirement.    This 
requirement is user selectable and can be as low as 60%, and as high as 100%.    The default
value is 80%.

Set the Percentage Requirement from the Advance to Next Level choice on the Options 
menu.    



A problem set is a group of problems that are given during any one game. If the maximum 
number of problems setting is less than the number of problems in the problem set, then 
problems are selected randomly from this set.



File Maintenance Menu
Use the File Maintenance Menu to:

1. Delete All Player Names and Records
2. Delete All Player Records
3. Delete Scores from the Hall of Fame
4. Delete All User Defined Problem Sets

Select the item you want to delete by selecting the corresponding menu item. All records in 
the selected catagory will be deleted.



To Order a Registered Version of Math Castle
Orders for Math Castle can be placed VIA Compuserve, Internet, Mail, Phone, or Fax.    Be 
sure to include the version you want, (Math Castle for Windows - for this version), along 
with your name, address, city, state, country, zip code and phone number.

Math Castle for Windows will normally be shipped on two 3.5" 1.44mb diskettes unless 
otherwise requested.    It is also available on 5.25" 1.2mb diskettes.    Please specify the disk 
format that your system requires.

If you are a member of Compuserve, you can place your order through Compuserve by 
typing GO SWREG.    From the Shareware Registration Menu, select the Register 
Shareware option, then follow the directions given on each screen.    When you get to the 
screen where you SELECT SEARCH CRITERA, use the Compuserve ID number as your 
search critera. Math Castle's Compuserve ID number is: 5325.    The program cost and 
shipping fees will be automatically added to your Compuserve bill.

Payment can be made through Compuserve, (see above), or with Cash, Check, Money Order,
VISA or MasterCard.    We also ship C.O.D. to locations within the United States.    All Credit 
Card orders must include your Credit Card Number and Expiration Date.

To place your order by phone call (509)465-0735.

To place your order by fax call (509)467-9481.

To order by mail please send your payment along with the information requested above to:

Attention:    R. Jennings
Northwest Software Engineers
PO Box 489
Nine Mile Falls, WA 99026-0489

My Compuserve Mail address is: 71461,2602.

My Internet Address is: 71461.2602@compuserve.com.

The cost to license Math Castle for use on a single computer is $19.95 US Dollars plus $5.00 
Shipping and Handling.    In addition, orders outside of the United States must add $5.00, 
C.O.D. Orders $5.00, Express Mail $12.00, and Priority Mail $4.00.    Washington State 
residents add 8% Sales Tax.

All orders will be shipped First Class Mail within 5 business days of receiving your order, 
except for Express Mail orders which will be sent out within 24 hours from the time we 
receive your order.

To print out a Math Castle Order Form, first click here which will display the Order Form on 
your screen.    Then select Print Topic under the File Menu to print it on your printer.

Note:    To properly install Math Castle, an Original Math Castle diskette is required.    Disk 
media is guaranteed for life and will be replaced free of charge by returning the original 
along with $5.00 Shipping & Handling.



Additional Versions
In addition to the Windows version, there are two more IBM versions available making Math 
Castle capable of running on virtually any IBM PC or compatible from the earliest 8088 
machines with only a floppy drive to the latest and most advanced hardware.    In addition, 
there are three Apple versions enabling Math Castle to run on most Apple II and Macintosh 
Computers. Click Here for more information.

Schools, Site Licenses, and Networks:    A Site License is required for Schools and other 
Multiple Station Users to use Math Castle on more than one computer per Original Copy of 
the program.    The network version of Math Castle is required in order for all stations on a 
network to be able to access Math Castle at the same time.    Please contact R. Jennings at 
Northwest Software Engineers for current pricing and/or for more information.



MATH CASTLE ORDER FORM
Ship To:

 Name                                                                                                                                                                    

 Address                                                                                                                                                                    

 City, State, Zip                                                                                                                                                      

 Country                                                                                                                                                                           

 Phone Number                                                                                                                                                      

Math Castle Pricing

    ________ Math Castle Registration $19.95
    ________ Shipping & Handling    $5.00
    ________ Orders Outside United States add $5.00
    ________ C.O.D. Charges add $5.00
    ________ Express Mail add $12.00
    ________ Priority Mail add $4.00
    ________ Washington State orders add State Sales Tax @ 8%
  ________ TOTAL $US (Add Above)

Select Payment Option

___ Compuserve

___ Check/Money Order enclosed

___ Pay C.O.D. on Delivery

___ VISA or MasterCard
    Credit Card Number:    _____________________

    Expiration Date:    _____________________

Select Version and Disk Format

Windows Ver. 2.0
    ___ 5.25" 1.2mb    ___3.5" 1.44mb

DOSVGA Ver. 3.11
    ___ 5.25" 1.2mb    ___3.5" 1.44mb

DOS CGA/Monochrome Version
    ___ 5.25" ___3.5"

Apple II
    ___ 5.25" only

Mac Plus
    ___ 3.5" only



Color Macintosh*
    ___ 3.5" only.    (See note below).

* Note:    At the time of this release,    the Color Macintosh version is not available, and a 
release date has not yet been set.    Please call to check on availability before placing your 
order for this version.

Send Order Form to:

Northwest Software Engineers
P.O. Box 489
Nine Mile Falls, WA    99026-0489

Phone: (509)465-0735
Fax: (509)467-9481

Compuserve Address:    71461,2602

Internet Address:    71461.2602@compuserve.com

Schools, Site Licenses, and Networks:    A Site License is required for Schools and other 
Multiple Station Users to use Math Castle on more than one computer per Original Copy of 
the program.    The network version of Math Castle is required in order for all stations on a 
network to be able to access Math Castle at the same time.    Please contact R. Jennings at 
Northwest Software Engineers for current pricing and/or for more information.



 Math Castle Version Descriptions
Math Castle For the IBM PC Family of Computers.
There are three versions available making Math Castle capable of running on virtually any 
IBM PC or compatible from the earliest 8088 machines with only a floppy drive to the latest 
and most advanced hardware.    Use the following version descriptions to select the version 
that is most suitable for your particular needs:

___ The Windows Version (2.0) supports VGA high-resolution graphics and Sound Blaster 
digitized sound.    Other features include context-sensitive on-line help, and student record 
keeping.    The high quality graphics, music, digitized sound, and other advanced features of 
this version make it a perfect choice for those with systems that are equipped with Windows.
This version requires a hard drive, Microsoft Windows, and a mouse.    A sound card is 
recommended but not required.    (Available on two 3.5" 1.44mb, or 5.25" 1.2mb diskettes).

___ The Dos Version (3.1) will run on any monitor type.    For systems with a VGA display and 
adapter card it supports the same high-resolution graphics as the Windows version.    Sound 
is produced on the PC speaker.    This version will run on systems that have 1.2MB (or more) 
of disk space on either a floppy or a hard drive.    To run in the VGA graphics mode, you need 
640K of RAM.    To run in graphics modes other than VGA requires only 512K.    (Available on 
3.5" 1.44mb or 5.25" 1.2mb diskettes).

___ The DOS Version (1.6) is recommended for systems that are limited in memory or disk 
space.    It supports all display types including Monochrome, CGA, EGA, and VGA, and can be 
ran from a floppy disk.    While this version does not support high-resolution VGA graphics, it 
will run on virtually any PC.    So if compatibility, speed, or hardward limitations is the issue, 
this is the version for you. (Available on 3.5" and 5.25" diskettes).

Math Castle For the Apple II
___The Apple II version is programmed to run on all Apple 2's and compatibles. It requires 
the standard 64k memory and one floppy drive.    It plays in the same basic way of the other 
versions except that some functions may take longer due to the hardware limitations.    
(Available on 5.25" diskettes only).

Math Castle For the Macintosh
There are two Macintosh versions of Math Castle available making Math Castle where it will 
run on almost all Macs.

___The Mac Plus version uses hi-resolution graphics and digitized sound. Answers can be 
input from the keyboard or with a mouse. Requires 1mb of RAM. (Available on 3.5" 
diskettes).

___* The Color Mac version uses full color hi-resolution graphics and digitized sound.    The 
high quality graphics, music, digitized sound, and other advanced features of this version 
make it a perfect choice for Color Mac users.    (Available on 3.5" diskettes).

* Note:    At the time of this release, the color Macintosh version is not available, and a 
release date has not yet been set.    Please call to check on availability before placing your 
order.



Technical Support
In case you experience difficulties in the installation or operation of Math Castle or the Math 
Castle Administrator program, product support is provided through:

Northwest Software Engineers
P.O. Box 489
Nine Mile Falls, WA    99026-0489

(509)465-0735 Voice
(509)467-9481 Fax

Compuserve Address:    71461,2602
Internet Address:    71461.2602@compuserve.com

Please consult Math Castle Help BEFORE calling for product support services.



 Math Castle Notices

Schools, Site Licenses, and Networks:    A Site License is required for Schools and other 
Multiple Station Users to use Math Castle on more than one computer per Original Copy of 
the program.    The network version of Math Castle is required in order for all stations on a 
network to be able to access Math Castle at the same time.    Please contact R. Jennings at 
Northwest Software Engineers for current pricing and/or for more information.



Publisher Information

The Math Castle Administrator for Windows is Published By:

Ron Jennings
Northwest Software Engineers
P.O. Box 489
Nine Mile Falls, WA    99026-0489

(509)465-0735 Voice

(509)467-9481 Fax

Compuserve Address:    71461,2602
Internet Address:    71461.2602@compuserve.com

Copyright (C) 1995 R. Jennings
ALL RIGHTS RESERVED



Overview
The Math Castle Administrator has been developed in response to the need that some 
users have to limit the students ability to access certain functions and utilities from within 
Math Castle.    This program is designed to provide the security needed to run Math Castle on
networks or in schools or other multi-user environments where some measure of control is 
needed.

The Math Castle Administrator enables you to configure and setup Math Castle in the 
manner you as the Administrator deem best.    It can also be used to prevent students from 
deleting their own records or other students records from the player database, and prevent 
the entry of frivolous names or more than one name per player.    You can also prevent a 
student from playing games using another student's name, (and thereby putting scores in 
another player's file), by requiring password identification before a player can gain access.

Use the Math Castle Administrator program to:
1.    Enter or Edit problem sets of your own
2.    Add players and assign passwords
3.    Set play options such as:

a.    sound device
b.    advancement requirements
c.    set for network usage
d.    skip introduction

4.    Perform file maintenance procedures such as:
a.    delete all scores from the Hall of Fame
b.    delete all player records in the Math Castle database
c.    delete all players and records from database
d.    delete all User Defined Problems sets

5.    View with the option to print:
a.    student scores found in the Math Castle Grade Book.
b.    list of students and passwords

In order to effectively use this program, if is recommended that you first familiarize yourself 
with Math Castle so that you can understand the effect that each selection that you make in 
the Math Castle Administrator will have on the operation of Math Castle.

Access to the Math Castle Administrator is password protected.    Once you have selected 
and entered a password, this password will be required in order to gain further access to the 
Administrator.    If you lose your password you must re-install Math Castle from the original 
diskettes in order to gain access again.

To select your password, select Set Administrator's Password from the Security menu.

On networks and other multiuser environments, it is recommended that you run 
the Math Castle Administrator program and select your password immediately 
after the installation of Math Castle is complete.    You need to do this BEFORE one
of your students does, (thereby locking you out).






